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Note pour les utilisateurs Mac

Certaines combinaisons de touches et certains éléments de menus sont différents entre un Mac et 
Windows ou Linux. La table ci-dessous donne quelques équivalents pour les instructions de ce 
chapitre. Pour une liste plus détaillée, voyez dans l'Aide.

Windows/Linux Équivalent Mac Effet

Sélection de menu 
Outils > Options

LibreOffice > Préférences Accès aux options de paramétrage

Clic droit ⌘+clic Ouvre un menu contextuel

Ctrl (Contrôle) ⌘ (Commande) Utilisé avec d'autres touches

F5 Maj+⌘+F5 Ouvre le Navigateur

F11 ⌘+T Ouvre la fenêtre Styles & Formatage
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Impression rapide

Cliquez sur l'icône Impression rapide  pour envoyer le document entier à l'imprimante par 
défaut définie pour votre ordinateur.

Note

Vous pouvez changer l'action de l'icône Impression rapide pour envoyer le 
document à une imprimante définie pour le document au lieu de l'imprimante par 
défaut de l'ordinateur. Choisissez Outils > Options > 
Chargement/enregistrement > Général et cochez Charger les paramètres 
d'impression avec le document (comportement par défaut).

Contrôler l'impression

Pour mieux contrôler l'impression, utilisez la boîte de dialogue Imprimer (Fichier > Imprimer ou 
Ctrl+P). Cette boîte de dialogue comporte quatre onglets, dans lesquels vous pouvez choisir une 
variété d'options, comme décrit dans les sections suivantes.

Figure 1 : Boîte de dialogue Imprimer

Note

Les options sélectionnées dans la boîte de dialogue Imprimer ne s'appliquent qu'à 
l'impression du document en cours. Pour fixer les paramétrages d'impression par 
défaut de LibreOffice, allez à Outils > Options > LibreOffice > Impression et 
Outils > Options > LibreOffice Calc > Impression. Voir Chapitre 14 (Paramétrer et 
personnaliser Calc).
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Sélectionner les options d'impression générales
Dans l'onglet Général de la boîte de dialogue Imprimer (Figure 1), vous pouvez choisir :

• l'imprimante (parmi les imprimantes disponibles) ;

• quelles feuilles et pages imprimer, le nombre d'exemplaires, s'il faut assembler les 
exemplaires multiples et s'il faut imprimer dans l'ordre inverse des pages.

Sélectionnez le bouton Propriétés pour afficher une boîte de dialogue spécifique à l'imprimante où
vous pouvez choisir parmi les options offertes par le pilote : filigranes, recto verso, qualité 
d'impression, etc.

Pour n'imprimer que certaines pages, séparez les numéros par des points virgules. Pour imprimer 
une plage de pages, insérez un trait d’union entre le premier et le dernier numéro de page. Vous 
pouvez combiner des plages de pages et des pages uniques. Par exemple : 1-3 ; 6 ; 8-9 
imprimera toutes les pages de 1 à 9 sauf les pages 4, 5 et 7.

Dans l'onglet Options de la boîte de dialogue Imprimer (Figure 2), vous pouvez choisir d'imprimer 
dans un fichier (et non vers une imprimante), de créer un seul travail d'impression comprenant les 
multiples exemplaires du document (et non un travail d'impression pour chaque copie) et d'utiliser 
uniquement la taille du papier suivant les préférences de l'imprimante.

Figure 2 : Options générales d'impression

Imprimer plusieurs pages sur une seule feuille de papier

Attention Le terme « feuille » désigne à la fois la feuille de papier sur laquelle le document 
sera imprimé et la feuille définie par un onglet du classeur. Il ne faut pas mélanger 
les deux notions.

Vous pouvez imprimer plusieurs pages sur une seule feuille de papier. Pour ceci :

1) Dans la boîte de dialogue Imprimer, sélectionnez l'onglet Mise en page (Figure 3).

Figure 3 : Imprimer plusieurs pages par feuille de papier

2) Dans la section Mise en page, sélectionnez dans la liste déroulante le nombre de pages à 
imprimer par feuille de papier. L'aperçu sur la droite de cette liste vous montre 
l'organisation des pages au sein du document imprimé.

Contrôler l'impression 6



Si vous imprimez plus de deux pages par feuille de papier, vous pouvez choisir l'ordre dans
lequel elles seront imprimées horizontalement et verticalement dans la feuille de papier. 
Les images ci-dessus et ci-dessous vous en montrent la différence.

3) Vous pouvez choisir de dessiner une bordure autour de chaque page ou non.

4) Cliquez sur le bouton OK.

Sélectionner les feuilles à imprimer
En plus d'imprimer le document en entier, vous pouvez choisir d'imprimer des feuilles individuelles 
(il s’agit ici des onglets du classeur), des séries de feuilles ou une sélection dans le document.

Figure 4 : Choisir quoi imprimer dans Calc

Imprimer une seule feuille :

1) Dans le classeur, cliquez sur l'onglet de la feuille que vous voulez imprimer.

2) Choisissez Fichier > Imprimer dans la barre de menus.

3) Dans la section Plage et exemplaires de la boîte de dialogue Imprimer, cochez l'option 
Feuilles sélectionnées.

4) Cliquez sur le bouton OK.

Imprimer une série de feuilles :

1) Dans le classeur, sélectionnez les feuilles à imprimer.

a) Sélectionnez la première feuille.

b) Maintenez enfoncée la touche Ctrl.

c) Cliquez sur les onglets des feuilles supplémentaires.

d) Relâchez la touche Ctrl quand toutes les feuilles désirées sont sélectionnées.

2) Choisissez Fichier > Imprimer dans la barre de menus.

3) Dans la section Plage et exemplaires de la boîte de dialogue Imprimer, cochez l'option 
Feuilles sélectionnées.

4) Cliquez sur le bouton OK.
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Imprimer une sélection de cellules :

1) Dans le document, sélectionnez les cellules à imprimer.

2) Choisissez Fichier > Imprimer dans la barre de menus.

3) Dans la section Plage et exemplaires de la boîte de dialogue Imprimer, cochez l'option 
Cellules sélectionnées.

4) Cliquez sur le bouton OK.

L'option Imprimer dans l'ordre inverse peut être sélectionnée avec chacune des possibilités 
énumérées ci-dessus.

Attention Après l'impression, pensez à annuler la sélection de votre série de feuilles. Sinon, 
en cas de saisie toutes les feuilles seront impactées, ce qui n'est 
vraisemblablement pas ce que vous souhaitez.

Utiliser des zones d'impression

Les zones d'impression ont plusieurs usages, comme imprimer uniquement une partie déterminée 
des données ou imprimer des lignes et colonnes sélectionnées sur chaque page.

Définir une zone d'impression
Pour définir une nouvelle zone d'impression ou modifier une zone d'impression existante :

1) Mettez en surbrillance la plage de cellules qui compose la zone d'impression.

2) Choisissez Format > Zones d'impression > Définir.

Les lignes de délimitation des pages s'affichent à l'écran.

Astuce

Vous pouvez vérifier la zone d'impression en utilisant Fichier > Aperçu. 
LibreOffice n'affichera que les cellules à l'intérieur de la zone d'impression.

Le mode Affichage > Aperçu des sauts de page permet également de 
facilement repérer la zone d’impression sans passer par l’aperçu avant 
impression. Voir "Afficher la zone d'impression" page 10.

Ajouter à la zone d'impression
Après avoir défini une zone d'impression, vous pouvez lui ajouter des cellules supplémentaires. 
Ceci permet d'imprimer plusieurs zones séparées dans la même feuille, sans avoir à imprimer la 
feuille en entier. Après avoir défini une zone d'impression :

1) Mettez en surbrillance la plage de cellules à ajouter à la zone d'impression.

2) Choisissez Format > Zones d'impression > Ajouter. Les cellules supplémentaires sont 
alors ajoutées à la zone d'impression.

Les lignes de délimitation des pages ne s'affichent plus à l'écran.

Note
La zone d'impression supplémentaire sera imprimée sur une page séparée, même
si les deux zones sont sur la même feuille.
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Supprimer une zone d'impression
Il peut devenir nécessaire de supprimer une zone d'impression définie, s'il faut imprimer la feuille 
entière par exemple.

Choisissez Format > Zones d'impression > Supprimer. Ceci va supprimer toutes les zones 
d'impression définies dans la feuille. Une fois la zone d’impression supprimée, les lignes de 
délimitation de page par défaut s'afficheront de nouveau à l'écran.

Éditer une zone d'impression
À tout moment, vous pouvez éditer directement la zone d'impression, par exemple pour supprimer 
ou pour redimensionner une partie de la zone d'impression. Choisissez Format > Zones 
d'impression > Éditer. Si vous avez déjà défini une zone d'impression, la boîte de dialogue Éditer
les zones d'impression ressemblera à celle de la Figure 5.

Dans cet exemple, trois plages sont sélectionnées, séparées chacune par un point-virgule. La 
première est délimitée par les cellules A1 ($A$1) en haut à gauche et la cellule D8 ($D$8) en bas à
droite. Les autres plages sont B16:C17 et G23:H24. Cliquez n'importe où dans la zone de saisie 
de texte pour afficher la zone d'impression en cours à l'écran, dans laquelle chaque plage 
sélectionnée est matérialisée par un rectangle d'une couleur différente, comme Figure 6.

Après tout changement, cliquez sur l'icône Réduire  à côté de la zone de saisie pour 
l'affichage des rectangles avec leur nouvelle valeur.

Pour étendre à nouveau la boîte de dialogue Éditer les zones d'impression, cliquez une nouvelle 

fois sur l'icône Réduire .

Figure 5 : Éditer une zone d'impression
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Figure 6 : Zone d'impression avec rectangles de couleur

Afficher la zone d'impression
La zone d'impression étant définie avec des sauts de page automatiques, elle peut être visualisée 
avec l'écran d'affichage des sauts de page, obtenu en sélectionnant Affichage > Aperçu des 
sauts de page depuis la barre de menus. La Figure 7 est un exemple d'aperçu à partir de la zone 
d'impression définie dans la Figure 5.

Les différentes parties de la zone d'impression sont entourées d'une bordure bleue par défaut et 
contiennent un numéro de page centré en grisé. La zone non imprimée a un arrière-plan en gris.

Pour sortir de l'écran d'affichage des sauts de page, sélectionnez Affichage > Normal depuis la 
barre de menus.

Figure 7 : Écran d'affichage des sauts de page
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Imprimer des lignes ou des colonnes sur chaque page
Si une feuille s'imprime sur plusieurs pages, vous pouvez paramétrer le fait que certaines lignes ou
colonnes se répètent sur chaque page imprimée.

Par exemple, si les deux premières lignes, ainsi que la colonne A, doivent être imprimées sur 
toutes les pages, effectuez les opérations suivantes :

1) Choisissez Format > Zones d'impression > Éditer. Dans la boîte de dialogue Éditer les 
zones d'impression, saisissez les lignes dans la boîte de saisie de texte sous Lignes à 
répéter. Par exemple, pour répéter les lignes 1 et 2, tapez $1:$2. Cela va modifier Lignes 
à répéter de – aucun – à – défini par l'utilisateur -.

2) Pour répéter des colonnes, saisissez-les dans la boîte de saisie de texte sous Colonnes à 
répéter. Par exemple, pour répéter la colonne A, tapez $A. Cela va modifier Colonnes à 
répéter de – aucun – à – défini par l'utilisateur -.

3) Cliquez sur OK.

Figure 8 : Définir des lignes à répéter

Note

Vous pouvez également sélectionner les lignes ou colonnes à répéter avec la 
souris. Pour ceci, positionnez le curseur dans la zone de saisie de texte 
correspondante, puis sélectionnez dans la feuille la plage de cellules désirée. Il 
n'est pas nécessaire de sélectionner des lignes ou colonnes entières : une cellule 
de chaque ligne ou colonne suffit.

Définir une zone d'impression personnalisée
En plus de mettre en évidence une zone d'impression pour chaque travail d'impression, vous 
pouvez définir une plage de cellules qui sera utilisée régulièrement. Ce peut être utile si un 
classeur important comporte différentes zones à imprimer pour différents rapports. Plusieurs zones
d'impression différentes peuvent ainsi être définies pour répondre à ce besoin.

1) Pour définir une zone d'impression, utilisez la même procédure que pour marquer une 
zone de la feuille. Mettez en surbrillance les cellules que vous voulez définir en tant que 
zone d'impression et sélectionnez Insertion > Noms > Définir. (Les cellules peuvent 
également être mises en surbrillance après l'ouverture de la boîte de dialogue Définir un 
nom.)

2) Dans la boîte de dialogue Définir un nom (Figure 9), saisissez un nom pour la zone dans le
champ Nom. Le nom de la zone ne doit pas contenir d'espaces.
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Figure 9 : Boîte de dialogue Définir un nom

3) Cliquez sur le bouton Options de plage et cochez ensuite l'option Zone d'impression. 
Cliquez sur le bouton Ajouter.

4) Cette boîte de dialogue permet également de définir un nom pour les plages de lignes ou 
colonnes à répéter. Procédez comme ci-dessus pour les points 1 et 2 et cochez Répéter la
colonne ou Répéter la ligne selon votre besoin. Cliquez sur le bouton Ajouter.

Pour éditer cette zone :

1) Choisissez Format > Zones d'impression > Éditer (Figure 5). La zone précédemment 
définie apparaît désormais dans la liste déroulante sous Zone d'impression. Les zones 
nommées de type Colonne ou Ligne à répéter figurent respectivement dans les listes 
déroulantes correspondantes.

2) Sélectionnez la zone d'impression définie et cliquez sur OK.

Cette méthode peut être utile pour changer rapidement la zone d'impression sans à chaque fois 
mettre en surbrillance une grande zone de cellules.

Sauts de page

Si la définition de zones d'impression peut être un puissant outil, il est parfois nécessaire d'ajuster 
manuellement l'impression dans Calc. Pour ceci, vous pouvez utiliser un saut de page manuel. Un 
saut de page manuel vous aide à vous assurer que vos données vont s'imprimer correctement. 
Vous pouvez insérer un saut de page horizontal au-dessus de la cellule active, ou un saut de page
vertical à gauche de celle-ci.

Insérer un saut de page
Pour insérer un saut de page :

1) Placez le focus sur la cellule où le saut de page va commencer.

2) Sélectionnez Insertion > Saut de page.

3) Choisissez Saut de ligne ou Saut de colonne selon vos besoins.

Le saut de page est alors paramétré.
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Saut de ligne
Saut de ligne va créer un saut de page au-dessus de la cellule sélectionnée. Par exemple, si la 
cellule active est H15, le saut de page est alors placé entre les lignes 14 et 15.

Saut de colonne
Saut de colonne va créer un saut de page à gauche de la cellule sélectionnée. Par exemple, si la 
cellule active est H15, le saut de page est alors placé entre les colonnes G et H.

Astuce
Pour voir plus facilement les sauts de page à l'écran, vous pouvez changer leur 
couleur. Choisissez Outils > Options > LibreOffice > Apparence et faites défiler 
la liste jusqu'à la section Classeur.

Supprimer un saut de page
Pour supprimer un saut de page :

1) Placez le focus sur la cellule près du saut de page à supprimer.

2) Sélectionnez Édition > Supprimer le saut de page.

3) Choisissez Saut de ligne ou Saut de colonne selon vos besoins.

Le saut de page est alors supprimé.

Note

Plusieurs sauts de ligne et de colonne manuels peuvent exister dans la même 
feuille. Si vous voulez les supprimer, vous devez supprimer chaque saut 
individuellement (voir l'astuce suivante). Ce peut être parfois difficile, car bien qu'il 
puisse y avoir un saut de colonne paramétré dans la feuille, quand vous allez à 
Édition > Supprimer le saut de page, le choix Saut de colonne peut être 
indisponible (grisé).

Pour supprimer le saut de page, vous devez être dans la cellule à côté de celui-ci. 
Par exemple, si vous avez défini un saut de colonne alors que vous étiez en H15, 
vous ne pouvez pas le supprimer si vous êtes dans la cellule D15. Cependant, 
vous pouvez le supprimer depuis n'importe quelle cellule de la colonne H.

Astuce
Vous pouvez également utiliser l'option Supprimer tous les sauts manuels du 
menu contextuel si vous avez sélectionné Affichage > Aperçu des sauts de 
page.

Paramétrage des options d'impression dans les styles de page

Plusieurs options d'impression sont paramétrées dans le style de page. Ce sont l'ordre des pages, 
le choix des éléments de la feuille à imprimer et l'échelle pour l'impression. Parce que ces options 
se trouvent dans un style de page, vous pouvez définir plusieurs styles pour modifier rapidement 
les propriétés d'impression des feuilles d'un classeur. Voir Chapitre 4 (Utiliser les styles et les 
modèles dans Calc), pour plus d'informations sur les styles de page.
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Figure 10 : Onglet Feuille de la boîte de dialogue Style de page

L'onglet Feuille de la boîte de dialogue Style de page (Figure 10) comporte les options suivantes :

Ordre des pages
Vous pouvez déterminer l'ordre dans lequel les pages vont s'imprimer. Ceci est 
particulièrement utile dans un grand document ; par exemple, contrôler l'ordre d'impression 
peut faire gagner du temps si vous devez assembler le document d'une manière précise.

Si une feuille s'imprime sur plus d'une page de papier, elle peut être imprimée par colonne (la 
première colonne de pages s'imprime, puis la seconde, et ainsi de suite) ou par ligne. Vous 
pouvez vous aider de l'aperçu en haut à droite de la boîte de dialogue, comme Figure 10.

Imprimer
Vous pouvez indiquer quels sont les éléments à imprimer. Ces éléments sont :

• les en-têtes de ligne (numéro) et de colonne (lettres) ;

• la grille : imprime les bordures des cellules comme une grille ;

• les commentaires : imprime les commentaires définis dans votre classeur sur une page 
séparée, avec les références aux cellules correspondantes ;

• les objets et les images ;

• les diagrammes ;

• les objets de dessin ;

• les formules : imprime les formules contenues dans les cellules au lieu de leur résultat ;

• les valeurs zéro : imprime les cellules avec une valeur de zéro ; sinon rien n’est imprimé.
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Échelle
Utilisez les fonctionnalités d'échelle pour contrôler le nombre de pages sur lesquelles les 
données seront imprimées :

• Réduire/agrandir l'impression : met à un facteur d'échelle plus grand ou plus petit les 
données dans l'impression. Par exemple, si une feuille s'imprime normalement sur quatre 
pages (deux en hauteur et deux en largeur), un facteur d'échelle de 50 % établira son 
impression sur une seule page (la largeur et la hauteur seront réduites de moitié).

• Adapter les zones d'impression en largeur et en hauteur : définit la hauteur et la largeur, en
nombre de pages, de l'impression.

• Adapter les zones d'impression au nombre de pages : définit le nombre exact de pages qui
seront imprimées. Cette option réduira uniquement l'impression, il ne l'agrandira pas. Pour 
agrandir une impression, l'option réduire/agrandir doit être utilisée.

En-têtes et pieds de page

Les en-têtes et pieds de page sont des morceaux de texte prédéfinis qui sont imprimés en haut et 
en bas d'une page, en dehors de la zone de page. Les en-têtes fonctionnent de la même façon 
que les pieds de page.

Les en-têtes et les pieds de page sont dépendants des styles de page. Vous pouvez définir plus 
d'un style de page dans un classeur et attribuer des styles de page différents aux différentes 
feuilles. Pour plus d'informations sur ces styles, voir Chapitre 4 (Utiliser les styles et les modèles 
dans Calc).

Paramétrer un en-tête ou un pied de page
Pour paramétrer un en-tête ou un pied de page :

1) Sélectionnez la feuille dont vous voulez paramétrer l'en-tête ou le pied de page. 
Sélectionnez Format > Page.

2) Sélectionnez l'onglet En-tête (ou Pied de page).

3) Cochez l'option Activer l'en-tête (ou Activer le pied de page).

À ce stade, vous pouvez également paramétrer les marges, l'espacement et la hauteur de l'en-tête
ou du pied de page. Vous pouvez cocher la case Adaptation dynamique de la hauteur pour ajuster 
automatiquement la hauteur de l'en-tête ou du pied de page.

Marges
La taille des marges gauche et droite ajuste la distance de l'en-tête ou du pied de page par 
rapport aux côtés de la page.

Espacement
L'espacement détermine la distance au-dessus ou en dessous de la feuille à laquelle l'en-tête 
ou le pied de page sera imprimé. Ainsi, si l'espacement est de 1 cm, il y aura un espace de 1 
cm entre la feuille et l'en-tête ou le pied de page.

Hauteur
La hauteur représente la taille de l'en-tête ou du pied de page.
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Figure 11 : Boîte de dialogue Style de page - En-tête

Apparence de l’en-tête ou du pied de page
Pour modifier l'apparence de l'en-tête ou du pied de page, cliquez sur le bouton Plus, ce qui va 
ouvrir la boîte de dialogue Bordure / Arrière-plan.

Figure 12 : Boîte de dialogue Bordure / Arrière-plan de l'en-tête ou du pied de page
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Dans cette boîte de dialogue, vous pouvez définir l'arrière-plan et le style des bordures de l'en-tête 
ou du pied de page.

Astuce
Vous pouvez utiliser l'arrière-plan pour insérer un logo dans l'en-tête ou le pied de 
page : dans l'onglet Arrière-plan, choisissez Comme Image et cliquez sur 
Parcourir pour aller rechercher cette dernière.

Paramétrer le contenu de l'en-tête ou du pied de page
L'en-tête ou le pied de page d'un classeur Calc comporte trois colonnes de texte. Chaque colonne 
peut être vide ou avoir un contenu différent.

Pour paramétrer le contenu de l'en-tête ou du pied de page, cliquez sur le bouton Éditer de la 
boîte de dialogue de la Figure 11. La boîte de dialogue de la Figure 13 s'affiche.

Figure 13 : Éditer le contenu d'un en-tête ou d'un pied de page

Zones
Chaque zone de l'en-tête ou du pied de page est indépendante et peut comporter des 
informations différentes saisies par l'utilisateur ou insérées automatiquement (voir ci-après).

En-tête
Vous pouvez faire un choix parmi plusieurs possibilités prédéfinies dans la liste déroulante En-
tête, ou définir un en-tête personnalisé comme dans la Figure 13 en utilisant les boutons ci-
dessous (pour formater un pied de page, les options sont les mêmes).
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En-tête personnalisé
Cliquez dans la zone (gauche, centrale ou droite) que vous voulez personnaliser, puis utilisez 
les boutons pour ajouter des éléments et modifier les attributs de texte. Vous pouvez 
également saisir un texte.

 Ouvre la boîte de dialogue Attributs de texte (le texte doit avoir été sélectionné).

 Insère le champ Nom de fichier.

 Insère le champ Nom de feuille.

 Insère le champ Numéro de page en cours.

 Insère le champ Nombre total de pages.

 Insère le champ Date.

 Insère le champ Heure.

Export au format PDF

Calc peut exporter les documents au format PDF (Portable Document Format). Ce format de 
fichier standard est idéal pour envoyer un fichier à une autre personne qui utilise Adobe Reader ou
un autre lecteur PDF.

Export rapide au format PDF

Cliquez sur l'icône Export direct au format PDF  pour exporter le document entier en utilisant 
les paramétrages PDF par défaut. Vous devrez entrer le nom et l'emplacement du fichier PDF, 
mais vous ne pourrez pas choisir les feuilles à imprimer, un intervalle de pages, un taux de 
compression des images ou d'autres options.

Contrôler le contenu et la qualité du fichier PDF
Pour mieux contrôler le contenu et la qualité du fichier PDF résultant, utilisez Fichier > Exporter 
au format PDF. La boîte de dialogue Options PDF s'ouvre. Cette boîte de dialogue comporte cinq 
onglets (Général, Vue initiale, Interface utilisateur, Liens et Sécurité). Effectuez les paramétrages 
appropriés, puis cliquez sur Exporter. Vous devrez alors saisir l'emplacement et le nom du fichier 
PDF à créer et cliquer sur Exporter pour exporter le fichier.

Général
Dans l'onglet Général, vous pouvez choisir quelles pages inclure dans le PDF, le type de 
compression à utiliser pour les images (ce qui va affecter la qualité des images dans le PDF) et 
d'autres options.

Export au format PDF 18



Figure 14 : Boîte de dialogue Options PDF - Onglet Général

Section Plage
• Tout : exporte le document entier si aucune zone d'impression n'a été définie ou le contenu

de ces dernières dans le cas contraire.

• Pages : pour exporter un intervalle de pages, utilisez le format 3-6 (pages 3 à 6). Pour 
exporter des pages individuelles, utilisez le format 7;9;11 (pages 7, 9 et 11). Vous pouvez
également exporter une combinaison d'intervalles de pages et de pages individuelles, en 
utilisant un format similaire à 3-6;8;10;12.

Attention Les numéros utilisés ci-dessus correspondent à des numéros de page et non à 
des numéros de feuilles de classeur. Pour repérer ces numéros de page, 
sélectionnez l'ensemble des feuilles du classeur et cliquez sur le bouton Aperçu.

• Sélection : exporte le contenu de la sélection en cours.

Note
La section Plage est inactive (grisée) si l'option Incorporer le fichier 
OpenDocument dans l'onglet Général est cochée.

Section Images
• Compression sans perte : les images sont exportées sans perte de qualité. Ce mode 

peut produire des fichiers avec une taille importante si vous utilisez des photographies. Il 
est néanmoins recommandé pour les autres types d'images et de graphiques.

• Compression JPEG : permet de faire varier le degré de qualité. Une valeur de 90 % 
fonctionne bien avec les photographies (petite taille de fichier et perte de qualité peu 
perceptible).

• Réduire la résolution des images : les images avec un DPI (dots per inch, points par 
pouce) faible ont une qualité médiocre. Pour l'affichage sur un écran, une résolution de 150
dpi est suffisante, alors que pour l'impression, il est généralement préférable d'utiliser au 
moins 300 ou 600 dpi, selon les capacités de l'imprimante. Des valeurs supérieures en dpi 
augmentent considérablement la taille du fichier exporté.
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Note
Les images EPS (Encapsulated PostScript) avec des aperçus incorporés sont 
exportées uniquement en tant qu'aperçus. Les images EPS sans aperçus 
incorporés sont exportées en tant qu'emplacements vides.

Section Filigrane
Vous pouvez incorporer un filigrane au document PDF en cochant Signer avec un filigrane et 
en saisissant le texte correspondant.

Section Général
• Incorporer le fichier OpenDocument : permet d'exporter le document comme un 

fichier .pdf contenant deux formats de fichiers PDF et ODF. Avec un lecteur PDF, il se 
comporte comme un fichier .pdf normal. Dans LibreOffice, il reste complètement éditable.

• PDF/A-1a : PDF/A est un standard ISO pour la préservation des documents, en 
incorporant toutes les informations nécessaires à une reproduction fidèle (comme les 
polices) et en interdisant d'autres éléments (comme les formulaires, la sécurité ou le 
chiffrement). Les repères PDF sont écrits. Si vous cochez PDF/A-1a, les éléments interdits 
sont grisés (indisponibles).

• PDF marqué : les PDF marqués contiennent des informations sur la structure du contenu 
du document. Ce peut être une aide pour afficher le document sur des périphériques avec 
plusieurs écrans, et lors de l'utilisation d'un programme de lecture d'écran. Les marques 
exportées comprennent la table des matières, les hyperliens et les contrôles. Cette option 
peut augmenter la taille du fichier de manière significative.

• Créer un formulaire PDF – Format d'envoi : choisissez le format des formulaires à 
l'intérieur du fichier PDF. Ce paramétrage écrase la propriété de contrôle de l'URL que 
vous avez fixée dans le document. Il y a un seul paramétrage commun valide pour tout le 
document PDF : PDF (envoie tout le document), FDF (envoie le contenu des contrôles), 
HTML et XML. Le format PDF est le choix le plus ordinaire.

• Exporter les repères de texte : exporte le nom des feuilles des documents Calc en tant 
que “repères de texte” (une table des matières affichée par certains lecteurs PDF, dont 
Adobe Reader).

• Exporter les commentaires : exporte les commentaires des documents Calc en tant que 
notes PDF.

• Exporter les pages vides insérées automatiquement : indisponible dans Calc.

• Incorporer les polices standards : vous pouvez choisir d'incorporer les polices Postscript
standards installées sur votre système (Times, Helvetica, Courier, Symbol, etc.) dans tous 
les documents PDF créés par LibreOffice, pour améliorer la précision de l'affichage dans 
les lecteurs PDF.

• Afficher le PDF après export : permet d'afficher le fichier PDF à la suite de sa création.
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Vue initiale
Dans l'onglet Vue initiale (Figure 15), vous pouvez déterminer la façon dont le PDF s'ouvre par 
défaut dans un lecteur PDF. Les options sont explicites.

Figure 15 : Boîte de dialogue Options PDF - Onglet Vue initiale

Interface utilisateur
Dans l'onglet Interface utilisateur (Figure 16), vous pouvez choisir plus de paramètres pour 
contrôler la façon dont un lecteur PDF va afficher le fichier. Certaines de ces options sont 
particulièrement utiles si vous créez un PDF destiné à être utilisé en tant que présentation ou 
affichage de type kiosque.

Options de fenêtre
• Redimensionner la fenêtre selon la page initiale : la fenêtre du lecteur PDF sera 

redimensionnée pour pouvoir afficher la première page du PDF en entier.

• Centrer la fenêtre sur l'écran : la fenêtre du lecteur PDF sera centrée sur l'écran de 
l'ordinateur.

• Ouvrir en mode plein écran : le lecteur PDF s'ouvrira en plein écran au lieu d'une petite 
fenêtre.

• Afficher le titre du document : le lecteur PDF affichera le titre du document dans la barre 
de titre.

Figure 16 : Boîte de dialogue Options PDF - Onglet Interface utilisateur
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Options d'interface utilisateur
• Masquer la barre de menus : le lecteur PDF masquera la barre de menus.

• Masquer la barre d'outils : le lecteur PDF masquera la barre d'outils.

• Masquer les contrôles de la fenêtre : le lecteur PDF masquera les autres contrôles de la 
fenêtre.

Transitions
Non disponible dans Calc.

Repères de texte
Indique comment les niveaux de titre sont affichés en tant que repères de texte, si Exporter les
repères de texte est coché dans l'onglet Général. Les Niveaux de repère de texte visibles ne 
sont pas utilisés dans Calc, mais dans Writer.

Liens
Dans cet onglet, vous pouvez choisir la façon dont les liens sont exportés en PDF.

Figure 17 : Boîte de dialogue Options PDF - Onglet Liens

Exporter les repères de texte comme destinations nommées
Si vous avez défini des noms de feuilles Calc, cette option les exporte en tant que “destinations
nommées” auxquelles les pages Web et les documents PDF peuvent être liés.

Convertir les références de document en cibles PDF
Si vous avez défini des liens vers d'autres documents avec des extensions OpenDocument 
(comme .ODT, .ODS et .ODP), cette option convertit le nom des fichiers en .PDF dans le 
document PDF exporté.

Exporter les URL relatifs au système de fichiers
Si vous avez défini des liens relatifs dans le document, cette option exporte ces liens dans le 
fichier PDF.

Liens entre documents
Définit le comportement des liens cliqués dans les fichiers PDF.

Sécurité
L'export au format PDF comprend des options pour chiffrer les fichiers PDF (afin qu'ils ne puissent 
être ouverts sans mot de passe) et appliquer des fonctions de gestion des droits numériques 
(DRM).
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• Si un mot de passe d'ouverture est défini, le fichier PDF peut être ouvert uniquement avec 
ce mot de passe. Une fois ouvert, il n'y a pas de restriction sur ce que l'utilisateur peut faire
avec le document (par exemple, l'imprimer, le copier ou le modifier).

• Si un mot de passe d'autorisation est défini, le fichier peut être ouvert par tout le monde, 
mais ses autorisations sont restreintes. Voir Figure 19.

• Si un mot de passe d'ouverture et un mot de passe d'autorisation sont définis 
simultanément, le fichier PDF ne peut être ouvert qu'avec le mot de passe et ses 
autorisations sont restreintes.

Note
Les paramétrages d'autorisations ne sont effectifs que si le lecteur PDF de 
l'utilisateur respecte ces paramétrages.

La Figure 19 montre la boîte de dialogue affichée si vous cliquez sur le bouton Définir les mots 
de passe dans l'onglet Sécurité de la boîte de dialogue Options PDF.

Une fois que vous avez défini un mot de passe d'autorisation, les autres options de l'onglet 
Sécurité (de la Figure 18) deviennent accessibles. Ces options sont explicites.

Figure 18 : Boîte de dialogue Options PDF - Onglet Sécurité

Figure 19 : Définir un mot de passe pour chiffrer un fichier PDF

Export au format PDF 23



Exporter en XHTML

Calc peut exporter les classeurs en XHTML. Choisissez Fichier > Exporter. Dans la boîte de 
dialogue Exporter, entrez un nom de fichier pour le document exporté, puis choisissez XHTML 
dans la liste Format de fichier et cliquez sur le bouton Exporter.

Enregistrer en tant que pages Web (HTML)

Calc peut enregistrer les fichiers en tant que documents HTML. Utilisez Fichier > Enregistrer 
sous et choisissez Document HTML, ou Fichier > Assistants > Page Web.

Si le fichier contient plusieurs feuilles, elles seront à la suite dans le fichier HTML. Des liens vers 
chaque feuille seront placés en haut du document. Calc permet également l'insertion de liens 
directement dans le classeur en utilisant la boîte de dialogue Hyperlien.

Envoyer des classeurs par e-mail

LibreOffice fournit plusieurs façons rapides et faciles pour envoyer des classeurs en tant que 
pièces jointes d'un e-mail, et ce dans l'un de ces trois formats : classeur OpenDocument (format 
par défaut de LibreOffice), Microsoft Excel ou PDF.

Note
Les documents ne peuvent être envoyés depuis le menu de LibreOffice que si un 
profil mail a été paramétré sur votre système.

Pour envoyer le document en cours dans le format OpenDocument :

1) Choisissez Fichier > Envoyer > Document par e-mail. LibreOffice ouvre votre client de 
messagerie par défaut avec le classeur (*.ODS) en tant que pièce jointe.

2) Dans votre client de messagerie, entrez le destinataire, l'objet et tout texte que vous voulez
ajouter, puis envoyez l'e-mail.

Fichier > Envoyer > Envoyer par e-mail en classeur OpenDocument a le même effet.

Si vous choisissez Envoyer par e-mail en Microsoft Excel, LibreOffice va tout d'abord créer un 
fichier au format Excel, puis va ouvrir votre client de messagerie avec en pièce jointe le fichier 
*.XLS.

De même, si vous choisissez Envoyer par e-mail en PDF, LibreOffice va tout d'abord créer un 
fichier au format PDF en utilisant les paramètres PDF par défaut (tels que si vous utilisiez le 
bouton de barre d'outils Export direct au format PDF), puis va ouvrir votre client de messagerie 
avec en pièce jointe le fichier *.PDF.

Envoyer un classeur par e-mail à plusieurs destinataires
Pour envoyer un document par e-mail à plusieurs destinataires, vous pouvez utiliser les 
fonctionnalités de votre client de messagerie, ou les fonctions de l'Assistant mailing de LibreOffice 
Writer pour extraire des adresses mail d'un carnet d'adresses.

Pour plus de détails, voir Chapitre 10 (Imprimer, exporter et envoyer par e-mail) du Guide du 
débutant.

Signature numérique des documents

Pour signer numériquement un document, vous avez besoin d'une clé personnelle, également 
appelée certificat. Une clé personnelle est stockée sur votre ordinateur et associe la combinaison 
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d'une clé privée, qui doit rester secrète, et d'une clé publique, que vous ajouterez à vos documents
quand vous les signerez. Vous pouvez obtenir un certificat auprès d'une autorité de certification, 
qui peut être une société privée ou une institution publique.

Quand vous appliquez une signature numérique à un document, une somme de contrôle est 
calculée à partir du contenu du document et de votre clé personnelle. La somme de contrôle et 
votre clé publique sont enregistrées avec le document. 

Par la suite, si quelqu'un ouvre le document sur n'importe quel ordinateur doté d'une version 
récente de LibreOffice, le programme procédera au calcul de la somme de contrôle et la 
comparera avec la somme de contrôle enregistrée. Si les deux sont identiques, le programme 
vous signalera que vous êtes bien en possession du document original non modifié. De plus, le 
programme peut afficher les informations de la clé publique du certificat. Vous pouvez alors 
comparer cette clé avec la clé publique publiée sur le site web de l'autorité de certification.

Si quelqu'un change quoi que ce soit dans le document, cela cassera la signature numérique.

Les systèmes d'exploitation Windows possèdent leurs propres fonctionnalités de validation de 
signatures. Sur les systèmes Linux, ces fichiers de validation sont fournis par Mozilla Thunderbird  
ou Firefox. Pour une description plus détaillée sur la façon d'obtenir et de gérer un certificat et une 
signature de validation, voir “À propos des signatures numériques” dans l'Aide de LibreOffice.

Pour signer un document :

1) Choisissez Fichier > Signatures numériques.

2) Si vous n'avez pas enregistré le document depuis la dernière modification, un message 
apparaît. Cliquez sur Oui pour enregistrer le fichier.

3) Après l'enregistrement, la boîte de dialogue Signatures numériques apparaît. Cliquez sur le
bouton Signer le document pour ajouter une clé publique au document.

4) Dans la boîte de dialogue Sélection d'un certificat, choisissez votre certificat et cliquez sur 
OK. 

5) La boîte de dialogue Signatures numériques apparaît de nouveau, et vous pouvez ajouter 
d'autres certificats si vous le souhaitez. Cliquez sur OK pour ajouter la clé publique au 
fichier enregistré.

Si un document est signé, une icône  est affichée dans la barre d'état. Vous pouvez double-
cliquer sur cette icône pour afficher le certificat.

Supprimer les données personnelles

Vous pouvez vouloir vous assurer que les données personnelles, les versions, les notes, les 
informations masquées ou les modifications enregistrées sont bien supprimées des fichiers avant 
de les envoyer à d'autres personnes ou de les exporter en PDF.

Dans Outils > Options > Sécurité > Options, vous pouvez paramétrer Calc pour qu'il vous 
rappelle (vous avertisse) que le fichier contient certaines informations lors de l'enregistrement, de 
l'envoi, de l'impression, de la signature ou de l'export au format PDF.

Pour supprimer ces données d'un fichier, choisissez Fichier > Propriétés. Dans l'onglet Général, 
décochez Utiliser les données d'identité et cliquez ensuite sur le bouton Rétablir. Les noms 
utilisés dans les champs Créé le et Modifié le, ainsi que les dates de modification et d'impression, 
vont être effacés, la date de création va être réinitialisée avec la date et l'heure courante, et le 
numéro de version va être remis à 1.

Pour effacer les informations de version, choisissez Fichier > Versions, sélectionnez les versions 
dans la liste et cliquez sur Supprimer. Ces informations de version sont également effacées si 
vous enregistrez le fichier sous un nom différent.
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